USING ADDITONAL TOOLS FOR EDITING

TRACE TOOL

Trace Tool is used to create segments by tracing over the segments/boundaries
of selected features.

1. Click the Editor Toolbar.
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2. Select the features that you want to trace. You must select some features
before you can start tracing.

5
3. Click the tool palette dropdown arrow and click the Trace tool I .

4. Click on the selected boundary segment to start tracing.
5. Move the mouse over the selected boundary to follow the trace.

¢ |If you have traced too far or traced the wrong direction, move the
mouse backwards over what you have traced.

¢ If you have clicked to stop the trace, click Undo to remove all vertices
added during the trace.

e In order to enable the Trace Tool, you must have features selected, and
target feature should not be of Point Type.
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e As you are tracing, you can change the selected features by clicking on
the Edit tool, changing the selection, and then clicking the Trace tool
again.

¢ A quick way to cancel a trace is to press the Esc key.

6. When you are finished tracing, you can double-click to finish the sketch.
SNAPPING

ArcMap can automatically connect (or snap) features placed within a certain
distance of each other. The rules specifying which features, and which feature
parts, snap to others make up the snapping environment. The distance at which
snapping occurs is called the snapping tolerance. In simple words, snhapping is
useful in cases where we need to connect two intersecting lines from a
common vertex. In such a case snapping automatically detects the distance and
point to be snapped.

1. From the Editor toolbar, select Start Editing and change the Target: to the
Roads layer.

2. From the Editor dropdown list, select Snapping (at the bottom of the
menu).
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3. The Snapping Environment window opens as shown above.

4, The snapping environment can help establish exact locations in relation to
other features. It can also be used to move a feature to a precise location in
relation to another feature. For this exercise we will use the default snap
tolerance.
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5. In the Snapping Environment window, check the box under the column
heading End for the Roads layer to enable end point snapping. Close the
Snapping Environment window.

6. Make sure Task: is set to Create New Feature and then select the Sketch
tool.

7. Edit the Roads layer by continuing the tracing on toposheet, as follows:

e Move the cursor (now shaped like a circle with crosshairs) to the
beginning (or end) of a Road Feature. Notice how the curser snaps to
the end vertex.

e Trace the road by clicking with the left mouse button at every change in
shape and intersection with other Road Features. Every time you click,
a new vertex is added.

 When you have finished, double-click with the left mouse button to stop
editing the feature.

SPLIT TOOL

Line and Polygon can easily be split in ArcMap. To manually split one line into

two, use the Split Tool | & . The line is split at the location where you clicked
with the mouse. The attributes of the original line are copied to each of the
new lines.

For splitting lines at a specified distance or percentage use the Split Command
on the Editor menu. It is used when the distance from either the first or last
vertex at which you want to split the line, or a certain percentage of the
original length is known.

To split polygons, use the Cut Polygon Features task. The polygon is split
according to a line sketch you create. The attributes of the original feature are
copied to each of the new features.

When you are splitting polygons, make sure your sketch cuts completely
through the selected polygon.
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Turning on edge snapping often helps ensure that the cut operation is
completed successfully.

SPLITTING LINES MANUALLY

1. Click the Edit tool ‘ o .

2. Click the line you want to split.

3. Click the Split tool | i on the Editor toolbar.

4. Click where you want to split the line. To split a line at the location where a
point feature falls on it, you can apply vertex snapping to the snapping
environment and snap the mouse pointer precisely to the point.

5. The line is split into two features.

SPLITTING LINES AT A SPECIFIED DISTANCE OR PERCENTAGE

1. Click the Edit tool
2. Click the line you want to split.
3. Click the Editor menu and click Split.

4. Click the first Split option to split the feature at a certain distance or the
second Split option to split the feature at a certain percentage of the whole.

5. Type a distance or percentage.
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6. Click From Start Point of Line if you want to split the feature starting from
the first vertex or From End Point of Line if you want to split the feature
starting from the last vertex.

7. Click OK.

8. The line is split into two features according to the parameters you specified.

SPLITTING POLYGONS

1. Click the Edit tool
2. Click the polygon you want to split.

3. Click the Current Task dropdown arrow and click Cut Polygon Features.
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4, Click the tool palette dropdown arrow and click the Sketch tool & ;

5. Construct a line sketch that cuts the original polygon as desired.

6. Right-click anywhere on the map and click Finish Sketch.

7. The polygon is split into two features.
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MERGE TOOL
The Merge command combines features of the same layer into one feature. It
however, does not create any new output, rather appends to the original. The

features must be from either a line or a polygon layer. The merged feature will
contain the attributes of the feature that appears first in the selection order.

1. Click the Edit Tool >

2. Click the features that you want to merge.
3.

xxxxx

3. Click the Target Layer dropdown arrow and click the layer that you want
the new feature to belong to.

4, Click the Editor menu and click Merge.

5. The selected features are merged into one.

UNION TOOL

The Union command combines features of the same shape type that may be

from different layers into one feature in the Target layer, while maintaining
the original features and attributes.

1. Click the Edit tool | o

2. Click the features that you want to combine into one.

ESRI India Pradeep Bhatt




3. Click the Target Layer dropdown arrow and click the layer you want the
new feature to belong to.

4, Click the Editor menu and click Union.

5. The selected features are combined into one.
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Georefrencing of a Toposheet

1) Open ArcMap, Start>>Program file>>ArcGIS>>ArcMap

2) Open toposheet (File format can be *.bmp, *.jpeg, *tiff etc) in ArcMap, it
will ask you to build a pyramid file. Click Ok to built a pyramid file (
Pyramid file is basically used to display raster file rapidly in different zoom

level)
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3) It will give information that the dataset is having an unknown spatial
reference; Click OK to add data in the ArcMap Environment, Data will be

added in the ArcMap.
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4) Open Georefrencing toolbar by, View>>Toolbars>>Georefrencing
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5) The toolbar will be activated in the ArcMap. Click on the Add Control
Point. The courser will be changed to the cross hair.
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6) Zoom into the upper left region in the toposheet (as shown).

Note: In ArcMap value of DMS have to be changed into the DD by the following
formula

DD = Degree + Minutes/60 + Seconds/3600

e e ar s
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7) Click on the add control point option in the Georefrencing tooibar. Left
click on the cross hair then immediately right click to add X (Long) , Y (Lat)
values for the point
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In this case values are as below
X =79.00 (Long)
Y = 26.75 (Latitude)
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Click Ok. Then similarly put rest of the three values (On each corner).

8) After putting all values, click on the view link table to know about the RMS
error.
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Click Ok to close the link table. Now image can be rectified.
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9) Click on Georefrencing Toolbar>> Rectify. A window will appear
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From the format drop down, file format can be selected. Click on save for the
rectification
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Click on File>>New for the empty document ( workspace).
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10)Add file, File>>Add data (navigate to the location where data have been
saved.) Select the file and click on Add to open file.
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Now opened data is in Degree Decimal, (check on the status bar)
Close ArcMap.
Assign Projection system to the rectified data

11) Open ArcCatalog, navigate to the location where rectified data have been
stored.

12) Right click on the Image, Click on Properties
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13)Property window will be opened, look for the spatial reference, click on the
Edit button.
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14)Spatial Reference window will appear, click on Select button for the
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For assigning CS, Double click on Geographic CS>>World>>WGS 1984
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This way Coordinate system will be assigned to the Toposheet.

The Pojection in this case is GCS-WGS 1984
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Re-projection (Project) of the Raster Dataset
15)To Project a raster, open ArcToolBox in ArcMap (or in ArcCatalog)
16)Navigate in ArcToolbox for the Project Raster Tool

Data Management Tools >> Projection and Transformation >> Raster >>
Project Raster
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# [ Favortes P viap
# (1 I1ECompatCache | A Create Custom Geogr
# (] IETidCache A Define Projection
+ (1 Local Settings 4 8 Raster
+ L] My Documerts + &% Relationship Classes
# (] NetHood | R Subbypes
# (L] Phone Browssr + & Table
+ (] PrintHoad + 8% Topology
+ (1 Privacte < & Versons v
+ (] Recent @ |k )
< TS 5 Favoitas [Index | Sesich| Resus < >

Transforms a raster from one projection to another,

Input Paster Input Raster

|  output Coordinate System

[ €:\Documents and Settings|pradeepiDesktop) \54n2_Gautaml.img
Input Coordinate System {optional) The input raster dataset
== 2]
Output Raster Dataset
[c\Documerts and e ad sktop|New Folder\54n2_Gautaml_P img EJ
|

| %rﬂ Transformation (optional)

|
o Lo L [

~
o | concel | envionaents.. | c<ridstep | roamep |
— - r il
+ 1 PrintHocd | 7 st
+ (0 PrwvactE [ > s v
+ [ Recent o | le )
¢ e > Favorites Search | Resulls < | 3

Transforms a raster from one projection to another,
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Define parameter I/O.
For output Projection system click on the Tool B

Again Click on Select >> Projected CS >>UTM >> WGS 1984 >> WGS 1984
UTM Zone 43N (As this data belongs to that region)

* Project Raster

e e
| ioput Raster ~| OutputCoordinate
[C\Documents and Sattings\pradeep)Desktop\Nen Folder|\S4n2_Gautam img E] System
| Input Coordinate System (optional)
[ 1 "I The coordinate system for
Output Raster Datasst T the geometry column
c [ Folder|S4n2_Gautaml tRaster | s
m::;:?d;:lm\md@\ gt PR P g The default is the same as
=ZyRen L in the Spatial Reference
[Wa5_1984_UTH Zore 430 Setlings smvirorment
Geographic Transformation (options) —
| T
* #
3 g
oK Cancel Envirorments... | << Hide Help E Tool Help
— 7 e
+ [ Printtiood A shift
# ) PrivaclE P Warp v
1 [ Recsnt 2| 1@ . >
(i ¥
¢ | o Favortes [Index | Seach| Feuﬂs_] < >
Trarsforms a raster from one profection to anather.

Tistart. o B " [leed Neimn, | [ Gemma e,

Click on OK to execute the Tool.

. ArcCatalog - Arcinfo - CiiDocuments and Sattings\pradeep\DesklopWow Falder

Project Raster: Elo [ Wew G0 Tios Wi bk

0|3 & aBBEEX LEHEA Q0N W [a8 "8 E|o]l
i % ccDuas | Lot [ \Domerts andsetngnensdesp D dico\Hlew Falder =,
T Chose v o when campletsd succesfuy Sptmbest.  [fEEF S =]
E ~ i iy - e T x| ol | Proview | Metadais | =
154311 PRINEN fitise Locaterven & 1 & Ostibuded Geodatabace A e Laype ] -
:. . I 542 _Gaktem 35 Foter Dntases z i g?‘;"( Rt ok asek
% sature Ci :
Stact Time: Fri Aug 13 17:33:41 2010 i 2 Sactam iy Rt Qateeet 3 dert + 85 Feanaes . rorbs
# ) AoplcaranData i B reids PRGEEEDT]  rter Doterd
v + 00 alins | F 85 e ceodstsbase
= = 1 Drshings | i & Geren
] B i @ Genesslasten : ® 0 ok i ¥ Generaizaton
§ 2 Ne el + 05 Indeies PR 4 2 Newcier + & Inderen
+ ] weskast ubyan + G Joms + L] weetlost M2t + 1y Jons
+ T Techweeidy det 4 8 Layers and Tabie Views + [ Techrweebiy det }8 Lapers and Tatka Vews
] Troesect v - & projecrons and Transfon # Bl Tinehest.dds = & Projections and Teersforn
3 () Favortes v & Frote + C Fovorre % 0% Foshre
+ () tECompatcache = & Raster « 0 teCorontache = 5 Raster
o ) ETCache rFa * ] EThCache A
= ] Local Sattings. 2 e o 1 ol Seters P
10 My Docuanenty A Project Raster # £ My Deaurenis A Project Rade
+ 1 tetriood 7 Rescoe 2 Meetwood P Rescse
+ (] Prone Eranser 2 Rots 4 L) Fhon Becwmcen P roers
+ C Praviood P s + O porvocd e
+ 3 prooacit P vno - ¥ 21 Private P vap -
+ Clpmeent ol |8 » ) Receot - e >
< Wy 5 Favoites [Indes | Seach] Resats] | ¢ » < 15 e Fates [rdes | Semch] Fests] | ¢ »

Trarsforivs o raster from one projection to anather, |
i star. OO0 B 7 e e O Sacaho | | oY ACORMEL | ) Protct Re [

T b A

e

The new file will be created.

Note: Same procedure can be applied to Project (Re-project) a vector data.

In ToolBox Navigate for the following tool

e —————————— e ey
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Data Management Tools >> Projection and Transformation >> Feature >>
Project
17) Now open the raster data in ArcMap (created using step-16). Check the
units of the Map in the Status Bar. It will be in meters.

% 'Untitled - ArcMap - /Arclnfo @@

Fa Edt View Bookmarks [nsert Selection Tooks Window Help

DEeE& '@ 0 o | & [T RARAT - N bR
gdtor | b | 2] ok =] I Ll
Gesreferencng = Layer [54n2_Gautam!_FrojectRiasterimg ~| ()|~ & &
3 5
M Red: Band i e | R
[l Green: Band 2 s | st
M Due: Band 3 L |
]
' ! ot
k .Ll“:“
Li]
¢
s
)
< b 3 N e
e
_Display | Source | Selection £ R J’J

ows~ h (1[0 7 A7 e e e

T e i

Vector Data format in ArcGIS Desktop
In ArcGIS Desktop data can be digitized in three forms

a) Shapefile: A shapefile is a digital vector storage format for storing
geometric location and associated attribute information. Shapefile doesn’t
store topological information.

Mandatory files:

. .shp — shape format; the feature geometry itself

. .shx — shape index format; a positional index of the feature geometry to
allow seeking forwards and backwards quickly

. .dbf — attribute format; columnar attributes for each shape, in dBase IV
format

ESRI India
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Optional files:

. .prj — projection format; the coordinate system and projection information,
a plain text file describing the projection using well-known text format

. .sbn and .sbx — a spatial index of the features

b) Personal Geodatbase : Stored in Access. 2 GB size limit, but effective size
is 250 to 500 MB per geodatabase. Windows only. Supports a single
editor and a few readers, extension is *.mdb

c) File Geodatabase: Stored in a file folder. Storage up to 1 TB per dataset.
cross platform (OS). Supports a single editor and a few readers, extension
is *.gdb

Note: Although Coverage is ESRI file format but data creation and editing

can only be done in Arcinfo workstation license.

Digitization of the Features

18) Open ArcCatalog, Navigate to the folder where data have to be created.
Right click >> New >> File Geodatabase

% | ArcCatalog - Arcinfo - C:\Documents and SettingsipradeepWeskiop\New Folder

| Bie Edt Vew Go Tools Window Heb

(2@ (REX|REME QIO N (A28 DE Y| e
Location  [C-\Documents and Settngs\pradeep\Daskiop\New Foider = O
e erscnal Geodatabase

Styesheet [T ] o # e B per
— O lve
e e * | Cortents | Praview | Metadsta | o y
# ] LocalService ok = & Dotrbted Geodatanase A S Layor
D A T Hor e B Swe
. + @& Feature Class - = 3
%0 idere - clinipts, ] 542 _Gautam1 mg
+ 21 Apolication Dats g Freids [ 54n2_Gautamt_FrojectRaster b B unFesture Class.
4 (1 Cockies + & Fie Geodatabase 20
= L Destbop B gc.emu ° Thoba
+ [ ddod 5 0 Gererakestion B gopy Cule ) avcirfoWorkspace
+ '3 New Falder # & Indexes i ] gBAsE Table
¥ (L] Weeklact Juy20 + 85 Yok )
+[E] Techi-weskly det = & Layers and Table views ¥ geite 8] o tatle...
+ [E] Tmesheet.xis Frojections and Transforn Rename  F2 P Coversge..
3 __j Favorites = Featurs o
4 £ [ECompatCache s i < Refresh W, address Locator..,
¢ Qe ) Freltseth 9 o e
# C Local Settings Frojact —
+ £ My Documents =S i;w B\ search...
4 (] NetHood Fip ks
o 8 3 o e
£ PrintHoad A Froject Rastar
T FrivectE P v
4 (£ Recent il 1% | »
Femisiiady e -
¢ > Favorias | Index | Sech| Reats| | ¢ 5

Creates a new File Geodatabase

Name it, ex: Dehradun.gdb
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Feature Class and Feature Dataset

Feature Class (FC): It is a collection of features having similar geometry,
common attribute table and a common projection system. (Ex: Building FC—

Collection of polygon geometry type)

Feature Dataset (FD): It is a collection of features having different geometry and
they fall in a common geographic area. (Ex. Dehradun FD: Road FC, Building
FC, Location FC etc)

19)Double click the database to open,
Right Click >> New >> Feature Class.

A window wizard will appear,

Wl et PR
N Name [Fosd B

Alias ‘

Styleshest Tree

Type of lealures stored in thes feature class:

3 LocalService

L} MetworkService
L] pradeep

b (] iderc

— Mulipont Features
-__| Application Data i MulliPatch Features

v (1 Cookies | Dimernsion Featuras

(1 Desktop Annatstion Featuies
+ [ dddd
= [ 2] New Folder

) oetredun.gdb

+ 8 s4n2_Gautam.) Geometiy Properties
i % o] | T oo ke M vakes sedto s ot data
+ ) Weeklast Jlyz010 ™ Cooidinales rnclude Z values. Used to store 30 data
+ ) Techi-weehly detals
+ ) Timesheet.xls
(2 Favorkes
(] IECompatCache:
(] ETidCache
b [ Local Settings
& (] My Documents
b (] NatHood
< ™l >

G

new Feature Class

T By e T

Fill Name; Select its geometry type; click on Next. (In this case Name :
Road, Type: Line Feature)

Click on Import to select the Coordinate System (CS).

e ———— e e e A S e P
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Add a field lik

ESRI India

Click on next, leave

Ble Edt View Go Took
o~ B B e N
[E"Documen:|
Steshest [0

1] LocalService
L] NetwarkService
1 pradeep
3 dierc
1) Application Data
{21 Cockies
) Desktop
# (] dédd
=1 (1] New Folder
[®) Detradun.gdb
+ Hf s4n2_Gautam.
+ B s4n2_Gautami |
+ B 54n2_Gautam!
1 (2] WesskLast Juby2010
#! ] Tech-weekly detail]

Locatian

+ @] Timesheet.xls
# (] Favorites

b [ ECompatCache
¥ (1 1ETkCache

& (1) Local Settings

# () My Documents

W

will be imported by this way)

as default click next, next,

e shown below, with text data type
: Nr;'wlnalure Class )

Field Name

OBJECTID
SHAPE
Name

| S 6 S ) L R R B 40 e R

Click ary lield to vee itz properties.

Field Properties

[pias

|Allow HULL veluss Yes
Defodt Value

Lengh 20

Import
To 8dd a new fiskd, type the nama into an empty 1ow in the Field Name cokumn, click in the
Data Type column to choare the data type, then edit the Field Properties

< Back Finish Cancel

nish. A file will be created.

Navigate to the file which was created in Step-16 (projection information

| Eie Edt View Go Jooks Window Help

o5y il

By Bt X | 2

TEEEE‘&;QQ.EIJQ W ea @eamn|o

ik

Location:

| Stylecheer L ’

1) LocalService
L] NetworkService
[ pradesp
b idlerc
b 3 Applcation Data
b (2] Cockies
F ] Dedtop
+ (] dodd
= () New Foldar
-0
+ ] 54n2_Gautam.JPG
+ S4n2_Gautam1.img
+ ] s4n2_Gautamt_Proj
+ ([ WeekLast July2010
+ [ Techi-weekly detals.xis
* Timesheet. xls
b (] Favorkes
k(] IECompatcache
(] IETdCache
b (21 Local Settings
& (1 My Documents.
() hetHood

oy Pban e Paamins

Crestes a new Festure Class
saistart,

PV e QL

[E\Documents and Sellings\piodeen\Deshtopi\New Foider\Debiadun o ]

| Conlents | Pravew | Metadata |

| ome | Type | startup |
Eary File Geodatabase Feature Class
Srorest Fie Geodatabase Feature Class
Zlrosd Fils Geadatabasa Festure Class

¥ AreCatsog - Areln...
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20) Open ArcMap, add above data

File >> Add Data or Select all data in ArCatalog then Drag and Drop data
from ArcCatalog to ArcMap

Eile Edt View Go Took Window Help

e P Eie Edt Wew Pookmarks Insert Sslection Tools Window Help
o | BRE X L, EmE e 5
© & |[TesEH =Hs
Location:  [CADocuments and Seltings\pradeep\Deskiod heds o il k4
| ) ¥ - ]
Stdesheet  [TOCir o] of 4 T8 i ' - l
e = al S Gaianl O el =
e ] Sl = | Lo (6402 Gotan]_ProsciFasiermg ~] ()'¥ @
[1 Locatservics ~ x
[} Networkervice w—gm” E & taves Q
1) pradeep S h Q
(1) e Slrorest S8 a
~ &5 L 4
b (] Applcation Data Erosd e iy
| ) oo @ - =
F ;_eresﬂw oM By
+ (1 dddd =] ®
=2 New Folder = @ sanz 1_Frojecth
+ [ pebradun.gdy =S R;gf"‘“" R
4 ] s4n2_Gautsm.JPG MERed: Band |
+ B 59n2_Gautaml img Sirsiices %
+ B stn2_Gautamt_fro) EE;:”B:E o R
# (1 WeekLast Jiy2010 #
+ [ Techi-weetly detads s
+ ) Timashest, s k
(2 Faverites [}
(1] IECompatCache
21 ETidcache 5 moadl ]
() Local Settings Display Souce | Selecton | S Jan &4 il
() My Documents TS e
1 nettond . Draving = K dlO= A~ L [0l =i+ ¢
SRR i i > 906263 756 2928483551 Meters

o Lt Bl Goete [edAcly | 6 u TEADTC - o R 5 Fioibe

21) To start editing (digitization); add editor toolbar in ArcMap by View >>

| 2|,
Toolbar >> Editor or click on!' *** 'icon.

22) Click Editor >> Start Editing; set the target layer (which you want to edit)

% Lintitled - ArcMap - Arcinfo

Bl Edt Yew Bookmarks [rset Selecton locks Window telp |

Select  Create New D%98 ‘@ o $fma 328000y
Edeey || | 2>| Tack [Cronta NewFestre =] twgec [ary — | mim‘_
Features from task option. & 12 =
-2 E (:Q‘
B oo o
5 - & Forest i)
Click on sketch tool to | _o .. . @
atans o | @ 13
P~ , o |
start edit = ' mouse will " ‘
i (]
be changed into cross “ A
hair o L I
Dighey [Souwce] Seksten ] [ [go 2w 4] i ﬁ.fj
e S L= S o e | L R P S A AR
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23) Zoom into the place where you want to digitize,

| Edior ~ _i-_ ?__| Task_ ICre?fe New Feature =] | Target: [ city =] |t € | E@ |
mE—— - -
= £ Layers @
E 2
- LR
Road ufls ; ‘
=
e & el s
= Forest i“‘? .:‘q&;”. uig\< h!l :}qua‘bu
E3 Y
= 54n2_Gautaml_ProjectR . { '_ s
RGE o
BmiRed: Band_1 o
[ Green: Band_2
M EBlue: Band_3 Qﬂ

Depending on the target layer sketch tool will behave as per geometry.
Layer Sketch Tool
City Point
Road Line
Forest Polygon

Click on the desired location to put a vertex (incase of line/polygon).

&_ Untitled - ArcMap - Arcinfo
File Edt View Bookmarks [nsert Selection Tooks Window Help

D& + B> v |+ B0 ERTAROE- Y=L vE

| Edtogw| b | @ ¥ Tesk: [Create Now Feature =] | Target: [Road

= & Layers
=M ay

.
= M Road

— iy P :&HMFFN >
= M Forest il » 4 ) § P,

= B 54n2_Gautaml_ProjectR

¢ > it
Display | Sourcs | Selection 'D & "
b~ k5 8]0 7 A2 raw—;uﬂuu A-dege e

I.enqth 169 B‘n‘ﬁn- Die::tlm 315mee Tnlallmgth ESla 217 m 910942, 582961504 551 Memf

iistart, || W f5

When you want to stop the digitization double click or Press F2 from
keyboard.
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% Untitled - ArcMap - Arclnfo, Q@EW

File Edt Yiew Bookmarks nsert Selection Jook Window Help
FHG s MBX o - FfEm ] &0 e

Edtorw| b | &~ Taski [Croots Now Fasture ~1 | Target: [fioad Sllxeaoa
—————— E
- £F Layers
- © oy S
. HH
= R n )
@ fo % ;&-wﬁ u:..wg :
= B Foest R Rt
(| f ; d
= B s4nz_Gautam!_Project? &
RGE -
Bfcd  Band ap B
[ Green: Band_2
M Eius: Band 3 [
o]
&
Li BH
L
& 3
L I
& f
< il
Display | Source | Selection

1
B R N S A

9]998} 117 2962273 322 M:Eu's

7 start e ]

u ll T b

To fill attribute in the digitized feature, click icon present in the editor

toolbar.

A window will appear fill attribute as per your requirement.

Eil= Edt View Bookmarks Insert Selaction Jook Window Help
DEEHS {BARX v Fﬁm AR T=R ]

1
| prawing = X (3 [ O v Alv| = a‘m vm-nng-&vﬁ-:-

mssn.m 296]432.179 l"!lsfs
e = oy

istart. | W O@ 7 . [

T e T T T e ———
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To save edits click on Editor >> Save Edits. Data will be saved.

Adding a field (Column) in the existing data

This can be done only when we are outside the editing mode. If you are in

editing mode Click on Editor >> Stop Editing.

Now Right click on Layer in the Table of Content (TOC) >> Open attribute
table.

= Untilled - Archiap - Arcinfo

Ele Edt Yow fookmarks fraert Selecton Tools Window Help

DEds& B> a g s EINTAT L R=EAll i )
= i V! p -

g v b P

= & Layer @ Copy

=B &K perove
Y-
-2 :: ok o elotes i
Table of content ——> _ & w=uum
W bl scdkfnge vt
E Usg Symidol Lok
gelaction [§
Labal Fasrres
& Convert Eeerurss ta Graphvcs
Conyert Symbology to Reprasentation.

OBJECTID: | SHAPE® | Hame | SHAPE Lengih q
* I'Pd)’rhlz (Nh-8 6579084454 @ Swikch Salection
ko,
— =] select st
e
= Turn Al Fields On
&l % ¥ Shoy Field Aliases
e ]
P ]:> Restore Defauk Calumn Weths
|n: Joins and Felstes »
et Related Tables »
f i Create Graph...
M": Add Tabie to Layout
Ru:ﬂd:ﬂﬂi_ = :J:ﬂ show: [[Al smdzd{ Reccrds (0 out of | Selected) _ Options - 4 - {3 Reload Cache
. - I Selectad Records (€
B NIRRT - — T T
l o F: h~ St 'w; e} 3. .” P Ty — . 5 Brint...
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Give name to the field and type of the data.

¥ _ o .
ited - Archap - Arclnfe | " L s Lol
P il ]

" OBJECTID * SHAPE * jllm SHAPE_Length
13 1 |Palylne Nh9 6579084454
il
o
Type Shart Integer ~ by
Shod Irteget 3
| Field Fropei{Lang Integer :J,
loal
A183 | Double |
Ao N SR 4
Detot ValDale
Blob
Raster e
uid

i et

o]
o s
e

Fie Edt View Bockmarks [nsart Selection Jook Wndow Help I

DEE& B e & [FE@ Cleani e
D e ey | W—|
e . 3
[ZE Loy
T =] BE79 Ca4451 hui )
ag ¢
-
i e
-@ %
2o
| |} §
e
..&1‘
)
e
nem-lj_j\ ER L FSI— Selected | Racords (0wt of | Selectad) ot | P
SN T ] ]eﬁﬂ Gpsaape: \“Q» “‘ e o k €

Display | Source] Selecton | stz w 4 b
aning = R EI'A' [[ereesl -__"|||u-n_;gA-a- A o

Similar type of steps can be followed to digitize the data (eg: Forest and
City)

]
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Labeling and Annotation

Label: Descriptive text placed next to the feature, they are dynamic (change their
position when panning and zooming done on them), they are handled as group
wise (color of individual label can’t not be changed), stored in .mxd document,
feature linked

Annotation: They are static, can be handled individually, can be store either in

.mxd or in geodatabase, can or can not be feature linked

24) Launch ArcMap, add data by clickingicon &

% Untitled - ArcMap - Arcinfa : .
Ele ESt Vew Gookmarks Inssit Selection Tools window Help |

DEH& - + [iEmE07 BRAR T - R=E R
e = | oo [

&2
=
2
5}
M
9}3 ¥,

1 =+ \“’”":g_r/}.h{\ v

k ,ﬂf f

(i) {"'

] ( 'i

%" A |
Display | Source | Selection dlaaaw |.|“
|orawig > & 0[O~ A~ o [aam =6 =] B s ulAv & gy o~

| 2738269409 1373237.091 Meters

T, v @ [Brhe o [l o -, [BHEE €805

e e —————
I — 7B
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25) Right Click on Layer in TOC >> Properties >. Label

Click on the check Box to actlvate Label featur
= Jinitisd - Aechap = Ateinfa,

Fis Edt Yiew Eonlmallr.; jnsar( gelection Tooks \gndnw Help

in tr]is layer.

| Edtor ¥ General | Sousco | Seloction | Display | Symbology | Fields | Definkion Query  Labielt | Jone & Relates | HTML Popup |
¥ Label faatures in this layer &
= L
@E”E Method [Label sl the fostuses the same veay =
Allfeatisies will be labeled using the options specifisd
Text Sting =
Label Field [State =] Esresson
FiD
Text Symbol id
o s =l
AaBbvyIz
b M- B|lz|U Symbol
Other Dptions Predefined Label Style
Placemer! Propetes SedleFarge. || LabelSies,. |
0K | Ceest | Aepy | =
Display |5 - ]
paving~ k 0 W O~ A~ 17 [olaa "“;Enfllﬁ"»“'d"’
Display the propeities of this layer

702841.653 1007736 465 Meters
Yistart OOl Wi s | = s !

Select the label field as per your requirement (as shown in the above fig),
click apply and OK.

Feature will be labeled in the display area.

. Untitled - ArcHap - Arcinfo

Flle Edt Vew Bockmarks [nsert Selection ook Window Help

Ded& - I 135,353,077 P&QD?*’Q’??
Edog | b [ @ ik [aav s e '7'7”_} I ["’ L i ]
= £F Layers @ (:::- iy
- o Q
5 HH
L]
®
-
i
k
Li]
“ mmaﬂct,ﬂu\!mﬂs
i m‘"{::’m;? ineds folciatediphcirclnd
¥ ‘r Mnm&mmuw
sna & Nicober | daras ol
Display [Source [ Selection ‘lap iz .| L
| prawing = K 1 [ O u-..;,n,.\vo,..;...é

3106059 41 157434.279 Vetors 3
Victart: S M@ " [@rbeci. | Do | o_Untked- . - [|yRrot QJ_Q!., W A7 O
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Conversion from Label to Annotation

26)Right click on the layer in TOC >> Convert from Label to Annotation

% _Untitled - ArcMap - Arclnfo

Ele Edt View Bookmarks [nsert Selection Tooks Window Help i

DEES| : =B = | fimmm L &90-NE
O [ S e e e m
E— —— | -

= & Layers  B® Copy
" 9 B X gorene
o s

Open Attribute Table
Joins and Relates

peungti ks
@& Zoom Tolayer si i
42 1 J
visble Scale Range Jons rran
Usg Symbol Levels o
Setection
|v |abelFeatures

Convert Lsbels to Annotation...

Aocdnana Amuw:
Aocdnena & [dans
Andnana & Nicober |gands

ZF Convert Features to Graphics...

Convert Symbology to Representation...
Qata Andmana & Nicobor | dards
Andnana & Nicober Idands ol
Diply [Sotace[ £ Save hsayerFie.. [
| o 2 k Create Layer Package... _A_- Mw v o~
Comvrt bl . 5. P - T R

start, el B (@ [H Sk

27) A window will be opened, give parameter and geodatabase location

where Annotation

!

will be stored

d Areilap - Arclp Ee %=}

Ble Edt Yew Bookmarks Jost

DE W&
Eoew| b | v Refererce Geals
= @ In 8 databace T Inthe map 1.36.363.077
= & Layers
=@ Cieate Anctation For
] 5 llfmalures © Fosuesnomertetert
F [ A
e ature Lager Lokad | Aerend Arnotafion Festure Clacs
Tnda_Slate O O irda_Statshro B
Create Annolation Feature Class
Loskin |75 Desktop - ﬂ:J au]:{] E
L3 tiew Foider
dweskiast Jiyzo10
Techi-weally detals s
Tineshestxls.
Destinationy [Urknown
| W Conwert urploced babels lo unplaced
Dy [Sousce] Selecton
| Drawng > R 0 F O AT S [a A
e LR * —t Hame. [india_StateAnna ]:

i start.

OOl " [ B 6 Uotded-,.. [l Menmot | @0 S0

ESRI India Pradeep Bhatt




Click on convert.

The converted Annotation
will be stored as a feature
class in the geodatabase,
which can be accessible
as and when require.
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Presenting Data

Switching to layout view

¢ Click the View menu.
e Click Layout View. The ArcMap window displays the entire map.
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How to add map elements

Adding a North arrow

1. Click the Insert menu and click North Arrow.
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Click a North arrow.

Click OK.

Click and drag the North arrow into place on your map.

Optionally, resize the North arrow by clicking and dragging a selection
handle.

Oy o o b

Adding a scale bar

Click the Insert menu and click Scale Bar.

Click a scale bar.

Optionally, click Properties to modify the scale bar's properties.
Click OK.

Click and drag the scale bar into place on your map.

Optionally, resize the text on the scale bar by clicking and dragging
a selection handle.

oo O 0 D~

Adding scale text

Click the Insert menu and click Scale Text.

Click a sample of the style of scale text to add to the map.

Optionally, click Properties to customize the scale text.

Click OK.

Click and drag the scale text into position on your map.

Optionally, set a specific font size for the scale text by choosing a font size
from the font size dropdown list on the Draw toolbar.

'OsU'l-b-(.qu\J—'

Adding a legend

p—

. Click the Insert menu and click Legend.

2. The Legend Wizard appears. If this wizard doesn't appear, wizards have
been turned off. When wizards have been turned off, a default legend will
be immediately added to your layout. You can double-click this legend to
change its properties. If you'd prefer to use the Legend Wizard when you
insert a legend, you need to turn wizards back on again: Choose Options
from the Tools menu and in the dialog that appears choose the
Application tab and check the 'Show wizards when available' box.

3. By default, all the layers on the map will appear as legend items in the

legend. To remove a legend item, click it, then click the left arrow button.

Use the Up and Down arrow buttons to order the legend items.

Click Next.

Type a title for the legend.

Set the text color, font, and size as desired.

Click Next.

Click the Border dropdown arrow and click a border.

10 Click the Background dropdown arrow and click a background.

11. Click the Drop Shadow dropdown arrow and click a drop shadow.

D e ee——————— e e e e )
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12. Click Next.

13. Click a Legend ltem in the list to modify the symbol patch.

14. Set the Patch properties as desired.

15. Click Next.

16.Set the spacing between legend elements by typing a value into

the appropriate box.

17.Click Finish.

Changing the patches in a legend

F- 0 R

Right-click the legend on the map and click Properties.
Click the Legend tab.

Click the dropdown arrow to select a new patch shape.
Click OK.

Changing the items in a legend

o

é.

7.

8.

9.

1. Right-click the legend on the map and click Properties.

2. Click the Items tab.

3.

4. Click the up and down arrows to move the item up or down in the

Click a legend item in the Legend ltems list.

legend.

Optionally, click Style and change the item's style in the legend.
Optionally, check Place in new column to place the item in a new
column.

Optionally, change the number of columns for the selected legend item
by clicking the up and down arrow keys.

Optionally, remove an item from the legend by clicking it and clicking the
left arrow key.

Click OK.

HOW TO ADD GRIDLILNES

Gridlines can be added and viewed only on Layout View. In Data View they
shall not be visible.

1. Click the View menu and click Data Frame Properties.

2. Click the Grids Tab.

3. Click the New Grid button.
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Uit Fraufls Mropartlss

Annotation Groups ] Extent Rectangles l Frame I Size and Position i Featuie Link |
General | DataFrame | Coordinate System | lumination — Giids | Mazp Cache |

Reference grids are diawn on top of the data frame in Layout view only ‘

New Grid.. [
L
Lo g ful
ez oo

ok | cencel | |

4. Select Graticules and click Next to continue.

Tl i Gratealzs

P — e ‘Which do you want to create?
R I

Ry : & Graticule: divides map by meridians and parallels
o0

s " Measured Gnd divides map inlo a gid of map units |
ror ‘

" Reference Grid: divides map inte a grid for indexing
e
|
0
Frs: r

Grid name: | Graticule

| Newt > | Cancel |

5. Click Graticules and Labels. Type the degree interval for which the grid is to
be drawn. Type Deg 0, Min 5, Sec 0 and Deg 0, Min 5, Sec 0 in respective
fields of Parallels and Meridians.
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-Appearance

" Labels only
™ Tick marks and labels RN

¥ Graticule and labels

i Intervals

Deg Min Sec

| Place paraliels every IU W |3U latitude
Place meridians every IU_ |—U_ |3U longitude

< Back 1 Next > | Cancel J

6. Click Next to continue.

7. Select Line Styles, if you need to change the appearance of the Grid. Click
Next o continue.

8. Click Next fo confinue, look around different options if required.

9. Click Finish to continue.

i Graticule Border

{* Place & simple barder &t edge of graticule
(" Place a calibrated border at edge of araticule

i Meatline

|
| I” Place & border outside the giid Ll
! [ace a border SIge Ine an TR

i Graticule Properties

™ Store as a static graphic that can be edited |

‘ - Store as a fixed grid that updates with changes to
the data frame

<Back | Fiish | Cancel |

10. Click APPLY and OK to Data Frame Properties dialog box.
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11. The Map shows the GRID on Layout View.

GRID LINES

NORTH ARROW

LEGEND  «—

Legend
Admind chad ve_Yehi ol _Eoundary

SCALE TEXT & BAR

B e e e e e e e e ]
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How to print a scene

Click the Print button.

Optionally, click Setup.

Optionally, click the dropdown arrow to select a printer.

Optionally, click the dropdown arrow to select a page size.
Optionally, click Portrait or Landscape to select the page orientation.
Optionally, click the dropdown arrow to select a printer engine.
Optionally, click OK.

Click OK on the Print dialog box.
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